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Viewing Website Content (Articles)

In the Joomla Administrator select Content = Articles from the main menu or click the Articles menu
item in the left side control panel under CONTENT to access all articles in the website.

In the Articles page all articles are listed. They can be filtered in a number of ways. To do that first click the
Search tools button, which reveals several drop-down menus. To see items by Category click the Select
Category drop-down menu and choose the desired category. To further narrow down the selection click
on one of the other drop-down arrows, for example the Select Author drop-down list and select one of
the listed names. Articles can also be filtered by Status, Access, Language Tag or Max Levels. To see
the contents of an article in edit mode click on its title in the Title column of the page.

Creating an Article

A single article is associated with a specific page on a website. To create a new article select Content ~
Articles from the main menu and then click the green New button (top left). Another way to create an
article is go to the Control Panel (System = Control Panel) and click New Article at the top of the
CONTENT list. This takes you to the Articles: New page.

There are several tabs at the top of the page each of which contains a respective set of fields and parameters that
can be set. The Title field appears above the tabs. The default tab is Content. This is where you’ll find the
Editor where content is added. When saved the new article is automatically given an Alias title (same as what’s
entered in the Title field) or the article creator may assign an alias. The Article alias 7usz be unique.

On the right side of the Content tab there are settings that determine a number of the article’s key
characteristics. This includes Status (Published, Unpublished, Archived and Trash), Category, Featured (Yes
or No to appear on the home page), Access type, Language, Tags and Version Note.

Settings in the Options tab allows an administrator to override globally defined article default settings.

In the Publishing Tab area there are a number of fields related to Dates that can be set for when an article is
created or published

For most purposes there won’t be a need to configure settings in the Images and links, Configure Edit
Screen or Permissions tabs.

Once content has been entered into the editor you can click the green Save button, Save & Close, Save
& New or Cancel button in the top left toolbar. Clicking the Save & Close button saves the article and
takes you back to the Articles page. Clicking Save saves the article but keeps you in the Article Editor to make
further changes. Clicking Save and New saves the article and sets up the creation of a new article. Clicking
Cancel takes the user back to the Articles page and a new article is not created.



Editing Content

Editing an article in Joomla is no more difficult to do than using a simple text editor. The material covered
here relates to the editor JCE.

To get into edit mode for an article go to Content = Articles in the main menu or click the Articles
icon/menu item in the Content list of the Control Panel. A quick way to find the desired article is to type
the first few letters of the article’s name in the Search field (left side), click the Search button and the articles
with a title containing the entered text will be listed. To enter edit mode click on the name of the desired
article in the Title Column.

The editor’s default mode is wysiwyg (what you see is what you get). In this mode you do not have to work
with code. If the text “Toggle Editor” is clicked then content can be edited in html code.

To edit an article click where you want to add or edit content. Just as in a standard text editor content can be
selected, deleted, modified, reformatted, etc.

To format content start by selecting what is to be formatted. Then click on the appropriate button for the
desired effect, for example the Bold or Italic button. The functionality of a button can be determined by
hovering the mouse over it and viewing the pop-up description.

There are instances when text formatting is not available through the toolbar buttons. Instead standard
predefined styles can be found in the Paragraph drop-down list and customized styles in Styles drop-
down list. An applied style can be removed by selecting the content that has been formatted and then click
the Remove Formatting button located on the top row to the far right.

To format content, for example change a short line of text into a heading, select the text and then click the
Paragraph drop-down arrow. A number of formatting styles will be displayed. Select the desired style, for
example, Heading 3. Once editing has been completed the administrator must click one of five buttons:
(located in the top left toolbar) Save (the page is saved and the article can be further edited), Save and Close
(the page is saved and the administrator is returned to the Article Manager), Save and New (the document
edits are saved and the administrator can then work on a new article) Save as Copy (the article is saved and a
new one based on the original is created, ready to be edited) and Close (edits are not saved and the
administrator is returned to the Article Manager.)

When an article is viewed in edit mode it is unavailable to other administrators. If, after editing, you happen to
click the browser's back button your unsaved edits will be lost. If you happen to close the page without clicking
Save or any of the other buttons in the top left area, the article will remain in locked mode. This means that
other administrators will not be able to access that article. It will be considered “checked out”. To unlock an
article you need to access that article in edit mode again and then click Save or one of the other buttons in the
top left toolbar. Once a document is saved it can revert back to an earlier version by clicking the Versions
button. When the Versions button is clicked a modal screen appears titled Item Version History. From
here one can select an earlier versions of an article to replace the current one by clicking the check box next to
the date of an earlier saved version and then click Restore.

When pasting content into the editor in design mode, formatting from another editor ( e.g. Word) is saved as
well. This is not a good practice. It's much better to paste or copy plain text and then use the formatting tools
of the editor. If, for example, you are composing a document in Word or WordPerfect, the content can be
copied into another simple text editor like NotePad and then copied from there and pasted into the Joomla



Internal Links

To create a link to another page in an article select the text that will form the link, then click the Insert/Edit
link button (horizontal chain link). The Link dialog box appears. The types of links that can be created are
listed in the Link panel. Typically a link to another page can be created from a Menu item. After clicking
Menu a tree hierarchy of articles are listed. This list represents content that has been linked to through one or
more menus. Navigate through the list to find the desired article that the link will go to. Once one of the
articles is selected and the Insert button is clicked the link is created. A quicker technique is to enter keywords
in the Search field, click the Search button and then click one of the listed pages.

There may be instances of articles that are not accessible through a menu item. To link to one of those articles
click the Content item in the Links list. An indented list will appear below the Content item representing the
main categories of the website. To create the link, navigate to the desired article by clicking on the category
name it belongs to and then the name of the article followed by clicking the Insert button.

To save the new link click the Save button in the top right toolbar of the page Article Manager: Edit
Article.

External Links

To create an external link, select the text that will form the link, then click the Insert/Edit link button.
When the Link Dialog Box appears enter the web address of the external link in the URL field near the top of
the dialog box. For an external links to open in a new window click the drop-down arrow next to the Target
field and select “Open in new window” and then click the Insert button to create the link.



Adding an Image to a Page

To add an image to an article, place the curser where you would like the image appear then click the
Insert/Edit Image button (top row).

After clicking Insert/Edit Image the Image Manager dialog box appears. At the top are 3 tabs. By default
the Image tab is open. This tab contains fields that set image parameters. It is considered good practice to
enter Alternate Text to describe the image. This is useful for when images are not viewable and search engine
optimization. Settings below Alternate Text should be ignored.

In the Advanced Tab there are optional fields for image settings. Text that was entered into the Alternate Text
field can also be entered into the Title field. Doing this will display text tips when the mouse hovers over the
image in some browsers. Styles can also be set to images by clicking the drop-down arrow in Class List and
selecting the preferred style, for example, image_centered.

In the File Browser panel you will see images in the Root folder by default. If you know that the desired image
exists in a different folder then navigate to it by clicking that folder and then select it. Once an image is selected
a preview image appears in the Details pane on the right side with information about the image above the
preview.

Click the Insert button (lower left corner) to place the image on the page.

If you place the image on the page without styling it or if you wish to change its style then you can add or
change the style by selecting it in the editor and then click the Styles drop-down button in the toolbar and
then select the desired style.

If the image you want to add is not on the web server but rather on your computer, click the Upload button
(middle button above the Details Pane title). After clicking the Upload button the Upload dialog box appears
where you begin the process of uploading an image from your computer to web server. There are two ways of
uploading images. One method is to click the Browse button. The files and folders on you’re computer will be
in view through your file manager application. Navigate to and then select the image to be uploaded and then
click the Open button. After clicking Open you’ll see the file listed at the top of the Upload dialog box. At this
point you can choose to upload the image by clicking the Upload button or click the Browse button to add
more images to the list. After clicking Upload the image or images are transferred to the server and will reside
in the open folder. The image title or titles will be bolded, which means the title is selected and can be added to
a page by clicking the Insert button.



Lists

Lists can take more than one form. An unordered bulleted list can be created from a set of paragraphs or
sentences separated by line breaks. To create the list, first select the lines of text or paragraphs that will form the
list. Then click the Unordered List button. By clicking the Unordered List button again the listed items
are changed back into individual paragraphs.

Rather than clicking the Bullets button you can click the Ordered List button to create an ordered numbered
list.

Adding an Menu Item to a Menu

Once a new page is created it cannot be accessed until it is linked from a menu or a link on a page. To add an
article link to a menu start by accessing a Menu. You can do this by clicking Menus in the main menu and
then select the desired menu, for example Global Menu. In the Control Panel you can also click Menu(s)
button from Structure Icons list and then click one of the Menus names in the Title column. You are then
taken to the Menus: Items page for that menu.

To create a new menu item link click the green New button in the top left menu. The Menus: New Menu
Item page appears.

The first field in the Details tab (default), Menu Item Type, is used to determine the type of link. To add
an article link click the Select button. A modal window appears with a list of link types. Click Articles,
Single Article. The text “Single Article” is then entered into the Menu Item Type field. Next, click the
Select button to the left of the “Select an Article” field. This brings up a dialog box from where you select the
article. This dialog box mirrors the way the Articles page works. After clicking the blue Search Tools button the
article list can be filtered by Status, Category, Access, Author, Language or Max Levels or enter text in the
Search box and then click the search button. The article is selected by clicking its name in the Title column
after which you are returned to the Menus: new Item page. The title name now appears in the Select Article

field.

Next enter a Menu Title, for example, “Board of Directors”. If this menu item is to become a submenu item
under, for example, About Us, then select About Us from the Parent Item drop-down menu. The other default
settings for Status: Published, Access: Public etc. can be left as they are. To create the menu link click the Save
button (to save settings but remain in the menu Menus: New Item page), click Save & Close (you will be
returned to the Menus: Items page) Save & New (the menu link will be saved and you go to the Menus:
Items page to create a new menu link) or Cancel (the link is not saved and you will be returned to the Menus:
Items page).

If the Save button is clicked the menu item will appear at the end of the list by default. The Ordering button
will become active and when clicked another menu item can be selected. The new menu item will appear
directly after the Ordering item. The order can be changed in the Menu Manager by clicking the double
up/down arrow button at the top of the left most column and then dragging the listed links into new positions.

At this point if you click the new menu item link on a web page, or, in this example “Board of Directors”, you
will go to a page you will see it’s corresponding side menu item on the. To make sure that menu is on the page
you must add the new menu link to it’s corresponding Menu Module.



Adding a Menu to a Page

Menus are a type of Module. Sidebar menus are set up so that they automatically appear on the page when its
corresponding menu item is placed within the hierarchy of a menu but not at the root level, that is it has a
parent menu item.

In some instances this does not happen. If a menu does not appear on one or more pages then to add it click
Extensions » Modules in the main menu or click the Modules link under the Structure list in the
Control Panel. This takes you to the Modules (Site) page. To narrow the list down to menu modules click
the Search Tools button to reveal a set of drop-down menus and the click the Select Type drop-down
menu and then select Menu. A new list appears showing only menu modules. To add a menu to one or more
pages click the menu name in the Title column of the menu to be added, then click the Menu
Assignment Tab and then check box to the left of one or more of the menu item titles and then click Save in
the top left tool bar.

Adding a Document to the System

The DOCman component adds a powerful tool set for managing documents in Joomla. To add a document
to the document management system click Components ® DOCman - Files in the main menu. The
Files page appears.

On the left side is a list of folders containing files. Select the folder where you would like the uploaded file to go
on the server then click the Green Upload button.

In the Upload dialog box you can drag one more files over the text “Drag files here” from a separate file
manager application or click the Add files button. Locate and select the file or files to upload and then click
the Open button. The selected file or files will be listed in the Upload files dialog box. Click the Start
upload button to transfer the files to the website. Once uploaded a green checkmark will appear to the right
of the listed files. The next step is to allocate the uploaded files to a DOCman category. To do this click the
Create documents button. This opens up the Batch Files page. To create the documents click the Category
drop down menu and select the category. You can scroll through the list or enter the name of the category in
the category field to filter out other categories. Once the category is selected click the Save button, to Save
the Documents and remain on that page or click Save & Close. This returns you to the Files page.

You can view how documents are organized on your website by accessing the Documents page. To see this
click the Documents link (near top left) or go to Components ® DOCman = Documents. In this page
all Documents are listed. You can view documents in one category by clicking a category link in the Categories
list.

The name of the document will be the same as its file name but without the extension. You can edit a

document’s settings by clicking on its name in the Title column. After changing a setting, for example, its
name, click the Save or Save & Close button (top left menu bar). After clicking Save & Close you are
returned to the Documents page. Generally documents are Published and Approved once they are added to a



Removing a Document

To remove a document from a category go to the Documents page (Components » Docman -
Documents). In the Documents page select the document you would like to remove by clicking the checkbox
to the left of its name and then click the Delete button (top left menu bar).

Note: Some documents are linked from within articles as text links. If a document is removed from a category
the link becomes broken. It’s good practice to keep a record of documents linked from within articles. Those
links should be removed as well when files become detached from documents.

Adding a Document Link to an Article

To link a Document to an article first access the article in edit mode. In the editor select the text that will link
to the document. Next click the Document button (below the editor). A dialog box appears. Navigate
through the folders to find the desired document. When the document you want is listed click on the name.
Click the Insert document link to link the document.

Click the Save or Save & Close button (top left menu bar) to save the change.



Working with Images

The images you use on your website will either be in a .gif, .jpg (also .jpeg) or .png format. .gif images are
used for logos, line art or simple illustrations. .jpg images for photographic images. .png improves upon the .gif
format. The images you add to pages should not exceed certain image dimensions, for example, a width of 750
pixels, or a given file size of 100 kB. You can use a File Management Application such as Windows Explorer to
access file size and image dimensions. To access dimensions in Windows Explorer view files in Details view. By
default image dimensions are not displayed. To see dimensions right-click your mouse in the area of the
column names and then select the last item More... Scroll down until you see the item Dimensions, click its left
side checkbox and then click OK. Now you should be able to see the image size and dimensions in Windows
Explorer (details view).

There are many image editors that used for general purposed image processing. If you are new to this consider
using an online editor such as Pixlr - http://graphicssoft.about.com/od/onlineimagetools/a/Pixlr-Editor.htm




